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Disclaimer

This document contains proprietary information of AM.P.S. LLC.
The reproduction of this material, in whole or in part, without the express written consent of
AM.P.S LLCisstrictly prohibited.

The information contained in this document is subject to change without notice. While every effort

is made to ensure the accuracy of the information in this document, AM.P.S. LLC offers no
warranty, expressed or implied, concerning the contents of this document.

Revision history

Version

Section Summary of change Reason for Change Initials | Date/Time

01

NA Initial Release NA MV 26 JUN 2012
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1. Proposed and Intended Usage

The new ViewerLIGHT provides the much improved graphical interface of the FDAEcG
SurTe, as it is based on the same code.

This AMPS application provides a way to display, review and validate ECG files in the
format supported by the FDA (HL7 XML) and other ECG traces generated with machines
from different manufacturers.

With the VZEwerLIGHT a single ECG can be loaded at a time.

The file display is achieved by means of a very intuitive, highly detailed and fully user-
customizable graphical interface. The ECG can be visualized in various formats, including
one lead at a time, superimposed leads and several others.

The graphic interface allows the user to review annotations previously obtained with
annotation software (CalECG, for example); annotations, when available, are in fact
visualized on the ECG tracings.

The validation tool checks that the files, which have been analyzed, are in the correct HL7
XML FDA format. Properly formatted HL7 XML FDA files increase the chances of a painless
submission to the ECG FDA warehouse.

The VIEWERLIGHT validator component only allows validating HL7 ECG files with the first
level of validation: Against Schema. The additional validation levels are available only with
the FDAECG SUITE.

2. Using the ViewerLight tool

2.1. Getting Started

Installation is activated by double-clicking on the downloaded file “SetupViewerLight-
2.0.x.exe”. After installation has been completed, the user can click on the link from the
‘AMPS’ folder in the Start Menu to launch the software (Figure 1), or double-click on the
shortcut on the desktop, if present.
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Figure 1: Launching the application from the Start menu.

When the application is launched, a blank window with a MenuBar and a Toolbar will be
displayed.

“viewer Light v.2.0.0RC11 _| IETES]

File Help
K@D AHC 6
Study Tree | view | vaidaton |

B @ Trials This element doesn't imply any graphical representation

D Mo document loaded

Figure 2: ViewerLight main display.
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2.2. Opening a file or directory

There are two separate file loading options available with the ViewerLiGHT that can be
accessed either from the File menu or the application toolbar:

"#yfiewer Light v.2.0.0
File Help

Open ECG

4

Dpen Studsy
Open URL

I's

open & Execute

Filter Data =

Sawe State
load State

Exit

« Open a single file or click on the toolbar icon [%
This option opens a new dialog where a single file can be selected.

Lack in: | =59 Demo

@9 001_1_H_POST_DOSE_FDA
{ E9001_z H POST_DOSE_FOA
MyFRecent  (2]001 & H_POST_DOSE_FDA
Documents 99001 _24 H_POST_DOSE_FDA
o 29 001_BASELINE_FDA
@00z _1_H_POST_DOSE_FDA
@00z 2 H_POST_DOSE_FDA
#002_6_H_POST_DOSE_FDA&
Y 00z_z4_H_POST_DOSE_FDA
.—-’) ] 002_BASELINE_FDA

@9 003_1_H_POST_DOSE_FDA
@4 003_2_H_POST_DOSE_FDA
9 003_6_H_POST_DOSE_FDA
ﬁ,g ©003_24_H_POST_DOSE_FDA
- 29 003_BASELINE_FDA

e

by Documents

Wy Computer

Q File name: 001_2_H_POST_DOSE_FDA v

MyMetwok | Filesof type: | FDAHLT Fies [*mi) ™

e Open a URL or click on the toolbar icon @ This loads files located in the
mentioned URL address.
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Both Open Study and Open & Execute options are only available in the FDAEcG SuITE.
Note again that with the ViewerLiGHT a single file can be loaded at a time.

2.2.1. Supported file formats

The only supported file format that can be loaded with the ViewerLicHT in HL7 XML FDA.

2.3. View Summary

The main application window shows the contents of the folder on the left (with the details
of the single loaded file), while on the right the ECG will be visualized:

!9 viewer Light v.2.0.0RC11 - C:\Program Files (x86)\AMPS\Viewer Light\Examples\Demo\002_1_H_POST_DOSE_FDAXml

_1_H_POST_DOSE _| EETES]
File - Help:
Fe@C AL @

SmdyTrzel View |uahdanm|

. rem o N N NDeicer iy

ode: PROT123 Iﬂ,z,‘?adf Elftosecnes ][z R = e Mi:n??aplurse:Munara Instrument, Inc. :

. MISSING_SITE_ID R e i o el b bl et s

BT ST e e e R e B DA i BN
&’ Vist: 1_H_POST_DOSE Leadl | i T ] =2 | 1

[l 16-Jun-2005 10:25:18 (10.0 o

| i e | I - i 1 !
a I T f 1 T

Figure 3: ECG visualization — Rhythm tracings display with Viewerlight.
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2.4. Left Pane: Tree representation

On the left side, the data is structured on a tree based organization.

This functionality is not of great interest as in the VieEwerLiGHT a single ECG can be loaded
at a time.

Data is grouped based on the same study, so all ECGs having the same 7ria/ Code will be
grouped together, in the same node of the tree (Figure 4).

The tree structure of the left hand side is similar to that of “Windows-Explorer”, with the
difference that instead of representing file folders, the elements of the tree group together
blocks of information from one or more HL7 XML file.

Study Tree |
=4 Trials

=-§ Trial Code: AMPS_STUDY_XYZ
=78 Site: 001
=R Subject: 001
- g Vist: D1_BASELINE
= 01-Dec-2007 02:00:00 (9.994 sec)
=@ Annotation Set
~yiem PR [1.478s - 1.645s] [Lead(s) Domain: 1]
-y PR [2.25s - 2.417s] [Lead(z) Domain: 1]
-y PR [3s - 3.1728] [Leadis) Domain: 1]
gl (IRS [1.644s - 1.7275] [Leadis) Domain: 1]
e (IRS [2.4175 - 2.5s] [Lead(s) Domain: 1]
gl (IRS [3.1725 - 3.255s] [Leadis) Domain: 1]
e (AT [1.644s - 1.554s] [Lead(s) Domain: 1]
i QT [2.4778 - 2.7612] [Leadig) Domain: 1]
gl (AT [3.172s - 3.5225] [Lead(z) Domain: 1]
~iem B [0.528s - 1.655s] [Leadis) Domain: I1]
~iem B [1.6545 - 2 4665] [Leadis) Domain: I1]
~yiem RR [2 4675 - 3.223s] [Leadis) Domain: I1]
[E+f— Dierived Series

-8 Annotation Set
El-g” Vist: D1_H1.0

- 01-Dec-2007 09:00:00 (9.990 sec)
- & Subject: 002
El‘ Visit: O1_BASELINE
= 01-Dec-2007 08:00:00 (9.990 sec)
. EFE@ Annotation Set
: -4~ Derived Series
- g Vist: D1_H1.0
- % Subject: 003
-7 Site: 002

Figure 4: Example of tree-structure of the left pane.

In order to have a more intuitive interface, each node has a different icon related to its
information level.

The structure of the tree contains the following information (based on its indention level):

1. Trial Code ®: the identifier (ID) of the study.
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2. Site Code ™®: the ID of the enrolling site.

3. Subject £: the subject Identification Code, included in the trial.

4. Visit # : examination ID, containing information on the examination: drug dosage,
etc.

5. ECG Session (Time Session) W': per each examination, one or more ECGs may have

been recorded.

Annotation [=: if annotations have been measured and saved, they are stored here.

Annotation Element #=: single annotation measured (type and duration are

reported).

8. Derived Series +—: contains the Representative beats, if present.

N o

To expand or collapse each node, click on the = or = symbol at the left of the node.

2.5. Right Pane

The right panel contains two tabs:

« View
» Validation
2.5.1. View

This tab is useful only when the selected nodes (on the left pane) are "ECG”, “Annotation
Set”, “Annotation Element” or “Derived Series” types: when there is ECG signal to be
plotted. If one of these nodes is selected, the ECG tracings with overdrawn annotations
(where available) are visualized.
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Figure 5: ECG visualization — Rhythm tracings display with ViewerlLight.
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Figure 6: ECG visualization — PR interval selected in the right display and highlighted in the ECG display.
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View I

I12Iead5 ﬂlﬂZsecunds LﬂE-mvurls _v_i

Toume ;
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Figure 7: ECG visualization — Superimposed Representative Beats are displayed, as "Derived Series” is
selected on the left display.

Display controls - Rhythm signal

Signals can be visualized in various different ways.

The control bar contains three drop-down menus indicating the number of leads, the
number of seconds and the amplitude resolution to be visualized.

|12Iead5 jlﬂl seconds j|2 mvols j

Allowed values are:
e Leads per page: 1to 12
e Time per page: 0.5t0 10 s
e Amplitude per lead: 1 to 5 mV
It contains three buttons showing the ECG tracings in three standard formats:
. , 3 X 4 format: three leads per row and four columns
. , 6 X 2 format: six leads per row and two columns

. @, 12 X 1 format: six leads per row on a single column

When the number of leads to be shown is lower than 12, a vertical scrollbar automatically
appears on the right hand side of the pane. It is also possible to scroll vertically using the

mouse wheel, or pressing the toolbar icon (for real-scroll mode activation) and then
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“dragging” the signal, using the left button of the mouse; the ECG can also be scrolled
horizontally.

When the time extension of the ECG is longer than the “screen paper size”, a horizontal
scroll bar appears at the bottom of the pane, so the ECG can be scrolled along the x-axis.

Moreover, if 6 X 2 or 3 X 4 formats are chosen, other horizontal scroll bars are visualized
to independently scroll one column of ECG tracings at a time, maintaining the others
unmodified.

The same goes for vertical scroll bars. If 6 X 2 or 3 X 4 formats are chosen and the user
decides to visualize less than 12 leads per page, other vertical scroll bars are visualized to
scroll between leads in a single column, maintaining the other unmodified.

Display controls - Representative Beats

If the “Derived Series” is selected on the left display, the Representative Beats of the ECG
are displayed in superimposed mode (SMB), as shown in Figure 7.

The toolbar icon allows to toggle the display between Rhythm and Representative
Beats ECG signals.

The toolbar icon @ allows to toggle on and off the leads superimposition.
When Representative Beats are displayed in superimposed mode, the View tab on the
right side will have an additional display control tool to vertically shift the visualized leads.

+

[] Wertical Shift

Measurement Controls

The toolbar icon | #+t toggles on and off the visualization of annotations.
If in the left panel an annotation node is selected and the visualization of annotations is
turned on, the selected annotation will be highlighted on the ECG, as shown in Figure 5,
Figure 6 and Figure 7.

Printing
The tool gives the possibility to print a screen-shot of the displayed ECG on the default
printer. The ECG screen-shot will be printed in the same way as the ECG is currently
displayed within the VZEWERLIGHT.

Options

The Settings Dialog can be loaded, from the ECG display window, by clicking the toolbar
icon LI , or by right clicking the mouse on the right hand side on the panel.
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This brings up the option dialog box where the user can edit several display options, but
can also modify options on the annotation format.

Display Options | Annotation Options | Signal options | Grid Options

The option dialog is divided into four tabs, as described below:

» Display Options

« Annotation Options
« Signal Options

e Grid Options

Display Options
x
Display Options | Annatation Options I Signal options I Grid Options I
— Superlmposition —— [~ Calibration Pulse — Display organization —
¥ into ECG
|_' Enabled = | | = EesemmEd p’ Show toolbar
i~ Out ECG
¥ Show global W Show timeline
annotation also — Scroll bars
when ™ Show vert bars % Above ECG
ts;g;nerg[;% on s ¥ Show hor bars " Below ECG

— Visualization parameters
Leads visualization order per column

#of Leads |3 |
# of seconds |5.[:-n ::|

# of millivolts IE.DE' a\VR

avll

WF
#ofcnlumnsl'l "I :.1

V2
ﬂ V3
j V4

[ ok | cancel |

This tab lets the user set some useful options related to the display of the ECG signal
(both rhythm and representative beats).

The calibration pulse can be drawn either on the ECG tracing or on its side by selecting in
the Calibration Pulse subpane “Into ECG” or “Out ECG” flag, respectively.

Both vertical and horizontal scroll-bars for each column (visualized only on 3 X4 and 6 X 2
formats) can be hidden (in Scro/l bars subpane).

Graphical toolbar can be hidden by unselecting the flag “Show toolbar” in the Display
Organization subpane. Once hidden, to re-visualize the Options window, right click the
mouse on the ECG screen.
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In this submenu it is also possible to hide the time x-axis ("Show timeline” flag) and to
chose if the time axis must be displayed of top or at the bottom of the right display
("Above ECG" or “Below ECG").

The ECG view can be set in superimposed mode, as opposed to standard “separated”
leads bEeIecting “enabled” flag in the Superimposition subpane, similarly as by selecting

button 4. In the previous pane it is possible to display global annotation (measured on
the SMB) also when the Representative Beats are not displayed in superimposed mode
("Show global annotation also when superimposition is toggled off” flag).

In addition to buttons and picks described here above, can be changed in the Visualization
Parameters submenu.

Here, the number of leads, the tracing duration and amplitude of the ECG, can be
modified.

It is also possible to change the number of column to distribute the visualized leads (1 to
4) and the leads’ order. First select the lead to be changed from the list (its label will
become blue), then click on the arrows to the left of the list to move the lead in the
desired position.

Annotation Options

x

Display Options  Annotation Options |5ignal options I Grid Options I

— Measurements Options

Measurement Type

—Measurement Color——————— [ Measurement Display
Calipers Region

|7 ¥ Calipers
- p H.egiun

Label
Change Culurl Change Cﬂlurl ™

— Selected Measurement Option

Color - Change Calor |

[ ok | cancel |

Here different colors can be assigned to the callipers and regions of different annotation
types. In the Measurement Display pane the user can decide whether to visualize callipers,
region and labels for every displayed annotation.
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In the Selected Measurement Option pane the user can select the colour to be used to
highlight selected annotations.

Signal Options

Settings Dialog

Display Options | Annotation Options  Signal options IGrid Optiors |

— Signal Calar

Change Signal Color

— Signal Display

Display Style IC::urrtinucuus 'I
Display Width |1 _Ij

Display Samples 0 =
position =

oKk |

Cancel |

In this tab, the user can choose the color and thickness of the ECG tracing. The signal is
typically designed continuously, but it can be drawn sample by sample. Finally, the
position of the ECG samples can be labelled at selected intervals on the tracings.
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Grid Options

Settings Dialog x|

Digplay Options I Annotation Options I Signal options  Grid Options |

—(Grd Options
: . Color
Resolution settings:
¢ Mimic 25 mm/s 10 mm/mV |
™ Mimic 50 mm.2 20 mm/mV/
= Mimic 50 mm/mV 10 mm/mV 2 LB BT |

{*' Custom, with the following parameters:

¥ ttime, miliseconds) Y (voltage, microvolts)

Thick Markcs IW "'I Thick Marks |5[;.|]. vI
Thin Marks |4D vI Thin Marks 100 -

[T Emphasize attemate grid thick lines

| QK I Cancel

The color of the grid can be selected in the Grid Color pane.

If desired the tracings can be visualized using a squared grid, instead of a rectangular grid
obtained from user’s customization of time and amplitude visualization setting (see above
Figure).
There are three possible squared grid that mimic typical paper ECG resolution settings:

« 25 mm/s and 10 mm/mV of paper speed and paper sensitivity respectively,

« 50 mm/s and 20 mm/mV of paper speed and paper sensitivity respectively,

« 50 mm/s and 10 mm/mV of paper speed and paper sensitivity respectively.

Once this setting is selected, in the ECG display will only be possible to configure one
setting at a time, between “time” and “amplitude”, the other will be set automatically to
guarantee the selected display setting.

Two examples of squared grid are here shown (Figure 8): the first based on mV, the
second based on seconds.
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Details | View | validation | Scoring Details | ¥iew | Walidation | Scoring
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Lead W2 Lead Il Lead W2 Lead Il

Lead 1

Figure 8: Two examples (a, b) of squared grid.

In Figure 8a the user can only choose the number of leads and the amplitude for each
lead, time menu is greyed out and automatically computed in order to keep the grid
squared.

In the second example the amplitude menu is automatically computed from the user’s
time selection.

Finally, with the forth option: “Custom”, the user can decide the time and amplitude
interval for both thick and thin grid linear marks both horizontally and vertically.

2.5.2. Validation

The validation tab is where the HL7 FDA XML format is checked for structure consistency.
The validation process of the VieEwerLIGHT computes a single level checks:

» FDA Warehouse Validation
Two additional validation steps are available only with the FDAEcG Surre.

» Implementation Guide Validation
« XML and Schema Validation
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To launch the validation of the loaded file select one of the two entries in the Validate
pane (“All loaded ECGs” or “Based on tree’s selection”) and press the start button.

With the ViewerLiGHT, both options will produce the same results, as only a single ECG can
be loaded at a time.

— Validate
= Al loaded ecas
™ Based on tree selection

Start |

Legend

Once the validation process is completed, a popup menu will show the results (Figure 9).

x

Total input files: 1

HL? aECG XML and Schema Validator:
1 of 1 file/s passed validation.

Legend | | OK I

Figure 9: Validation results summary.

Once the validation is computed, the results summary can always be shown again by

pressing the
For a better

pressing the

Fewview surmmary

button on the Resul/ts pane of the Validation tab.

Legend

understanding of this summary, a legend (Figure 10) can be visualized by

button.
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Legend

Step nok executed,

_-___l
m

The File(s) are ok; nothing to add,

Erroris) found!

0 xR

The file{s) are ok; suggestion(s) available,

The file(s) are ok warning(s) available,

Glossary

SUGGESTION: an advice to Further improwve andfor
complete the aECG abject,

WBRMING: alkough the file is correct we concerned
about a potential problem,

ERROR: something does not match with the
specifications

Figure 10: Legend of the Validation results summary.

Apart from the results summary (Figure 9), for all errors found there is a more detailed
overview, in the Validation pane itself (Figure 11).

Warning and errors can be expanded or collapsed each by clicking on the = or = symbol at

left of the text.

Moreover the display of the validation summary can be chosen between four formats:

« All reports grouped by file: warnings and errors are listed grouped by the file which

generated them

« Only errors grouped by file: errors are listed grouped by file
« All reports grouped by type: warnings and errors are listed grouped by their type
« Only errors grouped by type: errors are listed grouped by their type

Dizplay

All reparts grouped by file v

Ll reports arouped by file
of Oy errorz grouped by file
All reports grouped by type

Only errorz grouped by bype
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view  Validation |

r~ Validate
¥ Al laded ecgs
" Based on tree selection

Start

:

Legend

rDisplay——————————
All reports grouped by file 'I

r~ Results

Review summary

Copyto Export
clipboard to file

LIDATOR

4

El ERROR
Line: 17, Pos: 60
XPath:
XML —
Description: Datatype error: Type:InvaldDatatypeValueException, Message:Value 'tru’ does not match regular expression facet ‘true|false’.(System ID: C:\L

Figure 11: Validation Full Summary.

The validation report also provides information on the location inside the file that caused
the particular error (line number, position and Xpath (path in the XML structure), together
with a detailed description of the error/warning type).

Expnn
The button gives the option to export the complete results of the validation

Cupytu
process into a log-file, while the button copies the validation summary in the

clipboard.
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